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GLOSSAIRE 

 

DW  Biomasse sèche (Dry Weight) 

EIE  Espèce d’importance écologique 

FW  Biomasse fraîche (Fresh Weight) 

LAI  Indice de surface foliaire (Leaf Area Index) 

VAS  Végétation aquatique submergée 

ZIP  Zone d’intervention prioritaire. Comité ZIP :  organismes régionaux de 

concertation et d’action, dont le mandat est de regrouper les principaux 

usagers du Saint-Laurent. 
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INTRODUCTION 

La zostère marine est la principale phanérogame marine formant des herbiers marins le long des 

côtes québécoises. Classée espèce d’importance écologique (EIE) par Pêches et Océan Canada 

depuis 20091, elle contribue à la grande productivité et au maintien de la biodiversité des milieux 

côtiers tout en supportant de nombreux services écosystémiques2. À l’échelle mondiale, les éco-

systèmes de zostère marine sont globalement en décroissance3 et il est nécessaire de mettre en 

place des programmes de monitorage à long terme pour comprendre l’impact des changements 

globaux et des perturbations locales sur la dynamique des herbiers. L’un des enjeux principaux 

dans ces suivis est la nécessité de suivre des protocoles unifiés, répondants à de larges ques-

tions. Cependant, ces suivis sont déployés par des entités aux structures et aux moyens d’action 

variés (OBNL, Comités ZIP, entités gouvernementales, groupes de recherche universitaire, Pre-

mières Nations). Le déploiement et la réalisation des suivis doivent être adaptés aux capacités et 

réalités des gestionnaires locaux. 

Ce protocole est le fruit d’une réflexion menée pour standardiser les protocoles d’échantillonnage 

des herbiers de zostères marine à travers les différents programmes de monitorage, restauration 

et suivi de qualité des eaux au Québec. Sa première version a été rédigé en hiver 2024 à partir 

de méthodes appliquées et des données récoltées dans les herbiers de zostères marines de la 

Baie de Rimouski4 en 2020, 2022 et 2023, de l’Anse aux Huîtres5 (Kegaska) et de la Baie des 

homards6 (Port-Cartier) en 2019 et 2023, de la péninsule de Manicouagan7 (Baie-Comeau) en 

2019, en partenariat avec les Comité ZIP Rive-nord de l’estuaire, Comité ZIP Côte-Nord du Golfe, 

Comité ZIP du Sud-de-l’Estuaire et différentes équipes de recherche de l’Université du Québec 

à Rimouski (UQAR). Ce protocole a été ajusté suite aux échantillonnage terrain réalisé en 2024 

par les équipes nommées ci-haut. Ce protocole propose une série de métriques mesurées à 

différentes échelles organisationnelles (cellule, individu, communauté, écosystème), reliées à 

l’état écologique des herbiers marins le long de la section marine du Saint-Laurent (excluant les 

VAS d’eau douce). Afin de capturer la variabilité spatiale présente au sein des herbiers, ce pro-

tocole présente un plan d’échantillonnage en cible (voir la section Plan d’échantillonnage).  

 
1 Barrell (2009) 
2 Murphy et al. (2021)  
3 Orth et al. (2006) 
4 ISMER-UQAR, Chaire UNSECO en gestion intégrée des systèmes marins (dir. Fanny Noisette) 
5 Comité ZIP Côte-Nord du Golfe 
6 IDEM 
7 UQAR et UQAC, Projet WISE-Man  
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MÉTRIQUES  

Les indices de recouvrement, d’abondance des épiphytes et de nécrose des plants par quadrat 

(indices semi-quantitatifs ; voir échelle ci-dessous), la longueur moyenne et maximale par qua-

drat, la densité des plants et la biomasse fraîche (FW) par unité de surface sont évaluées direc-

tement sur le terrain. Ce protocole permet aussi (en fonction des moyens dont l’équipe disposera) 

d’évaluer le nombre moyen de feuilles par plant, l’indice de la surface foliaire (LAI ou Leaf Area 

Index) par échantillon et la biomasse sèche (DW) par unité de surface. S’il est impossible pour 

l’équipe de traiter les échantillons pour obtenir la DW, celle-ci peut être déterminée à partir d’une 

relation masse fraiche-masse sèche établies à partir de données précédemment récoltées à Ri-

mouski en 2023. Un indice préliminaire est présenté dans la section Indices (p. 16). 

Classe 0 1 2 3 4 5 

Recouvrement 0% 0 à < 25% 25 à < 50% 50 à < 75% 75 à < 100% 100% 

 

PLAN D’ÉCHANTILLONNAGE ET MATÉRIEL 

Ce plan a été choisi en raison de sa facilité d’application dans les milieux médiolittoraux (à pied, 

à marée basse) et infralittoraux (en plongée). De manière optimale cet échantillonnage devrait 

être effectué à la même période chaque année pour faciliter les comparaisons interannuelles. La 

période recommandée correspond au moment du maximum de biomasse (mi-fin juillet pour l’es-

tuaire maritime). Cette période pourrait varier d’une région à l’autre, en fonction de la phénologie 

des herbiers. L’échantillonnage devra être déployé un minimum d’une fois par été dans chaque 

site de l’herbier. Un site de l’herbier est considéré comme une aire qui englobe des conditions 

(substrat, fragmentation, gradient de profondeur, etc.) sensiblement uniformes. Lorsque l’herbier 

est très grand, il peut y avoir plusieurs sites par herbier (p. ex : bordure de l’herbier et centre de 

l’herbier). 
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Figure 1 : Design d’échantillonnage en cible. Chaque ton de vert représente une zone d’échantillonnage. 

Réplication : 3 échantillons (position aléatoire dans chaque zone d’échantillonnage) pris sur chacun des tran-

sects ; 4 transects de 50 m par cible. 

 

Design d’échantillonnage en cible (figure 1) 

 Mouillage avec sondes enregistrant les conditions environnementales telles que 

la température, la salinité, la pression et la lumière; 

 Transect : ruban de mesure extérieur (≥ 50 m); 

 2 piquets en plastique ou pole de PVC 70 à 100 cm (pour fixer le transect); 

 GPS.  
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Mouillage (figure 2) 

Un mouillage muni de sondes paramétriques est installé dans l’herbier pour la durée de 

la saison estivale. Les sondes mesurent les paramètres suivants :  

1. Lumière et température : HOBO Pendant MX Temperature/Light Data Logger 

MX2202 connexion Bluetooth (https://www.onsetcomp.com/products/data-log-

gers/mx2202) OU HOBO Pendant Temperature/Light 64K Data Logger UA-002-

64 (https://www.onsetcomp.com/products/data-loggers/ua-002-64) connexion par 

fil à HOBOWare.  

2. Pression/hauteur d’eau : HOBO Water Level Data Logger U20L-04 (13 ft) 

(https://www.onsetcomp.com/products/data-loggers/u20l-0x) connexion par fil à 

HOBOWare (facultatif) 

3. Conductivité/salinité : HOBO Salt Water Conductivity/Salinity Data Logger U24-

002-C (https://www.onsetcomp.com/products/data-loggers/u24-002-c) connexion 

par fil à HOBOWare (facultatif) 

 

Figure 2 : Schéma du mouillage déployé dans l’herbier. Le mouillage doit être fixé au fond avec une ancre et 

identifié par une bouée flottante (sphère rose). La longueur de la corde de la bouée doit être équivalente à 

1,5 x la hauteur d’eau à marée haute. Le schéma est présenté à titre indicatif, la forme et des dimensions du 

mouillage peuvent varier en respectant les conditions suivantes : les capteurs de pression/hauteur d’eau (2) 

et de conductivité/salinité (3) doivent être installés le plus près du substrat parallèle au sol ; les capteurs de 

lumières (1) doivent être disposés de façon à ne pas se faire de l’ombre. Le premier doit être placé le plus 

près du substrat et le second à une hauteur ≤ 1 m du substrat.  

https://www.onsetcomp.com/products/data-loggers/mx2202
https://www.onsetcomp.com/products/data-loggers/mx2202
https://www.onsetcomp.com/products/data-loggers/ua-002-64
https://www.onsetcomp.com/products/data-loggers/u20l-0x
https://www.onsetcomp.com/products/data-loggers/u24-002-c


Protocole d’échantillonnage des herbiers de zostère marine dans le système Saint-Laurent (mars 2025) 

 

7 
 

Le mouillage est composé d’une structure à base triangulaire en aluminium avec en son 

centre une tige perpendiculaire en aluminium (figure 2). Les capteurs doivent être fixés au 

mouillage à l’aide d’attaches rapides (zip-tie ou colliers rilsan) résistantes aux intempéries 

et au rayonnement UV avec cran en inox (par ex : https://new.abb.com/pro-

ducts/7TAG009210R0050/ty28mx). La base triangulaire peut être remplacée par une 

base ronde composée de poids d’entrainement. 

 

Personnel requis : 3 personnes 

Temps estimé par personne par site (n = 4 transects déployés par site) : 

• Préparation : 1 personne x 1 jour 

• Travail sur le terrain : 3 à 4 personnes x 1 jour (½ journée :AM) 

• Traitement des échantillons (biomasse) : 2 personnes x 1 jour (½ journée :PM)8 

• Mesure de la LAI et saisie des données : 1 personne x 2 jours  

Matériel pour le terrain 

 2 grands sacs à dos ;  

 Boussole pour placer les transects à 90°; 

 12 grands sacs plastique hermétique (ZIPLOC) préidentifiés  

 3 quadrats 50 cm x 50 cm percés et munis de piquet pour ancrer dans le sédiment; 

 3 quadrats 25 cm x 25 cm percés et munis de piquet pour ancrer dans le sédiment; 

 2-3 paires de ciseaux ; 

 Ruban à mesurer en nylon (ruban de couture) ; 

 Feuilles de notes ou cahier de terrain résistant à l’eau; 

 Vignettes d’identification (site, transect et quadrat) facultatif; 

 Crayons à mine ; 

 Grenouillère pour chaque technicien·ne·s de terrain (Waders) ; 

 Gants étanches et doublés (si nécessaire pour l’eau froide); 

 Appareil photo résistant à l’eau facultatif; 

 Glacière + pain de glace pour le transport facultatif ; 

 

 
8 Le travail de terrain et le traitement des échantillons se font la même journée, idéalement, par 
les mêmes personnes. 

https://new.abb.com/products/7TAG009210R0050/ty28mx
https://new.abb.com/products/7TAG009210R0050/ty28mx
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Traitement des échantillons en laboratoire (LAI, FW et DW) 

 2-3 essoreuses à salade ; 

 Papier absorbant ou chamois. 

 Balance de précision; 

 Sacs en papier brun (pesés après séchage)9 ; 

 Règle 30 cm en plastique ; 

 Étuve ; 

 Tableau blanc (ou surface blanche) ; 

 Support universel ; 

 Appareil photo (ou téléphone cellulaire avec une bonne résolution) ; 

 Crayon permanent ; 

 Étiquettes d’identification ou crayons effaçable pour tableau blanc. 

MÉTHODE  

Préparation (4 à 5 jours précédant le terrain) 

 Imprimer la feuille de terrain ou préparer le cahier de terrain (voir annexes); 

 Charger l’appareil photo et le GPS ; 

 Identifier les sacs plastique hermétiques (date, site, transect, quadrat) ; 

 Biomasse sèche (DW) : sécher les sacs de papier 48 h à 60 °C. Identifier les sacs 

d’un numéro unique, peser les sacs et noter la masse sèche sur le sac.  

Terrain 

1. Atteindre le mouillage ou le point GPS désigné comme le centre de la cible. Planter 

une pole de PVC dans le substrat pour désigner le centre de la cible ; 

2. Déployer le ruban à mesurer depuis le centre en direction du large sur 50 m. Noter la 

direction dans laquelle est déployé le transect à l’aide de la boussole (p. ex. 35° NE) ; 

3. Sélectionner une (1) station aléatoirement dans chaque zone de la cible :  

▪ Intérieure : 0 à 17 m ;  

▪ Moyenne : 17 à 33 m ;  

▪ Extérieure 33 à 50 m. 

 
9 Il est essentiel de sécher les sacs de papier à l’étuve et de noter leur masse une fois complètement secs 
avant de les utiliser pour les biomasses de zostère. L’humidité pourrait fausser les données de DW. 
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Pour chaque station :  

4. À l’intérieur du grand quadrat (50 cm x 50 cm) noter le pourcentage (à 5% près) ou la 

classe de recouvrement (0 à 5, voir section Métriques), de couverture par les plants 

de zostère, par les épiphytes et par les plants nécrosés10 ainsi que le recouvrement 

du quadrat par les autres macrophytes (algues brunes, algues vertes, etc.); 

5. Si nécessaire, photographier le grand quadrat avec les vignettes d’identification (site, 

transect et quadrat); 

6. À l’intérieur du grand quadrat, déposer aléatoirement le petit quadrat (25 cm x 25 cm). 

Exclure les plants qui se trouvent à l’extérieur du petit quadrat en passant les mains 

au ras du substrat en suivant le contour du quadrat et tirer délicatement les feuilles 

vers l’extérieur, fixer le petit quadrat au substrat à l’aide de piquets en métal ; 

7. Rassembler tous les plants dans une main (former un bouquet) pour s’assurer que 

tous les plants ont bien été répartis de part et d’autre du quadrat. 

8. Cueillir et compter les plants dans le petit quadrat un par un en coupant au ras de la 

racine avec l’ongle ou avec des ciseaux. Noter le nombre de plants en floraison 

(feuilles plus longues et rigides, vert clair et contenant des graines). Si la densité dans 

le quadrat est uniforme et élevée, dénombrer seulement ½ quadrat et noter la pro-

portion du quadrat qui est cueillie. Noter le nombre de plants cueillis et éviter de faire 

des calculs directement sur le terrain. 

NOTE : couper les plants entre le nœud 0 et le nœud 1 (en dessous du renflement présent 

sur la gaine du plant ; voir figure 3) 

9. Placer les plants dans le sac en plastique identifié pour la station et refermer le sac 

hermétiquement. Rapporter les échantillons au laboratoire en les gardant au frais dans 

un sac à dos ou dans une glacière. 

10. Répéter les étapes pour les trois autres directions cardinales, en pivotant le transect 

dans le sens horaire à 90° (p ex : SE -> SO -> NO -> NE). 

 

 
10 Le pourcentage de recouvrement du quadrat et non le pourcentage de plants qui sont nécrosés. Par 
exemple : si le quadrat a un recouvrement de 60% de zostère et que la moitié de celles-ci sont nécrosés, 
le pourcentage de recouvrement par des plants nécrosés sera de 30%.  
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Figure 3: Sectionner le plan en dessous du nœud (indiqué par la flèche). 

Traitement en laboratoire 

Biomasses et mesures morphométriques11   

Pour chaque échantillon :  

11. Sortir les plants du sac et les agiter dans l’eau douce (ôter tous les épiphytes et les 

invertébrés qui pourraient y être attachés) ; 

12. En les examinant un par un, couper les racines restantes sur chaque plant : à l’aide 

d’une paire de ciseaux ou avec l’ongle, entre le nœud 0 et le nœud 1 (en dessous du 

renflement présent sur la gaine du plant ; voir figure 3) ; 

13. Mettre de côté trois plants médians (pour les mesures morphométriques) ainsi que le 

plant le plus long de l’échantillon;  

14. Placer le reste de l’échantillon dans l’essoreuse et faire tourner 3 fois, puis placer les 

feuilles dans un sac en papier numéroté et prépesé. Garder le sac de côté en atten-

dant de compléter les mesures morphométriques ; 

  

 
11 Deux méthodes peuvent être utilisées pour estimer l’indice de surface foliaire (LAI) : par calcul à partir de la longueur et 

la largeur (point 18 à 28) ou par estimation de l’aire des feuilles (points 29 à 39) 
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Longueur maximale  

15. Mesurer le plan le plus long et noter sa longueur sur la feuille terrain; 

16. Essorer le plant et l’ajouter au reste de l’échantillon dans le sac de papier; 

Pour chaque plant sélectionné (3 par échantillon) :  

17. Couper les feuilles à la base de la gaine puis, sur une surface blanche, étaler chaque 

feuille l’une à côté de l’autre parallèle à une règle graduée, ainsi que la gaine perpen-

diculairement aux feuilles (figure 4). Pour faciliter le travail, les feuilles doivent être 

lissées sur la surface avec le bout du doigt et un peu d’eau ; 

18. Installer l’appareil photo sur un support universel pour stabiliser l’appareil. L’appareil 

doit toujours être situé dans le même angle et à la même hauteur ;  

19. Prendre une photo de toutes les feuilles, de la règle graduée et de l’étiquette d’identi-

fication du quadrat (date, site, transect, quadrat, replicat) ; 

 

Figure 4 : Toutes les feuilles d’un plant de zostère disséquées et étalées parallèles à l’étalon de mesure. Une 

photo par plant, 3 plants par échantillon. 

Exemple d’étiquette : [20-04-2023_T01_Q02 ; R1] pour le plant (réplica) 1 de l’échantillon 

du quadrat 2 sur le transect 1 récolté le 20 avril 2023). 
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20. APRÈS LES MESURES MORPHOMÉTRIQUES : Éponger les feuilles et remettre 

tous les plants dans le sac de papier de biomasses. Peser le sac et son contenu pour 

obtenir la masse humide ; 

21. Placer ensuite les sacs à l’étuve à 60 °C pour 48 h, puis peser à nouveau pour obtenir 

la masse sèche. 

NOTE : si un déshydrateur alimentaire est utilisé pour faire le séchage, le temps de sé-

chage pourrait varier. Pour s’assurer que la biomasse ait complètement séché, noter la 

biomasse à plusieurs reprise (une à deux fois par jour) jusqu’à ce que la masse soit stable 

3 pesées consécutives. 

 

Détermination des mesures morphométriques pour calculer l’aire des feuilles avec logiciel 

d’analyse photo ImageJ  

22. Ouvrir la photo d’un plant dans le logiciel ImageJ12 

Étalonnage de la photo :  

23. Avec l’outil Strait line tracer une ligne de longueur connue (p. ex : 10 mm) sur l’étalon 

de mesure présent sur la photo (règle graduée); 

24. Dans le menu Analyze, sélectionner l’option Set scale (figure 6). Une fenêtre s’ouvrira ;  

25. Dans la fenêtre Set Scale entrer la longueur connue (10) dans la case Known distance 

et l’unité de mesure (mm) dans la case Unit of lenght. Appuyer sur OK (figure 7). 

 

 
12 Logiciel d’analyse d’image gratuit et libre de droits. https://imagej.net/ij/download.html  

https://imagej.net/ij/download.html
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Figure 5 : Outils de tracage Segmented line et Strait Line 

 

 

Figure 6 : Sélectionner l'outil Set Scale 
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Figure 7 : Entrer la mesure et l’unité de mesure dans la fenêtre Set scale (encerclé en rouge) 

 

Mesure des feuilles : 

26. Sur une première feuille, tracer une ligne allant de la base de la feuille à la pointe de 

la feuille. Utiliser l’outil Segmented line lorsque la feuille est courbée de manière à 

maintenir la ligne au centre de la feuille (figure 5) ; 

27. Dans le menu Analyze, sélectionner l’option Measure (ou Ctrl+M). Un tableau s’ouvrira 

et la mesure sera indiquée dans la colonne Lenght; 

Mesurer ainsi la longueur et la largeur de chaque feuille. 
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Figure 8 : Utiliser l’outil Measure ou Ctrl + M pour déterminer la longueur d’une ligne tracée avec l’outil Seg-

mented line ou Strait Line. 

 

Mesure de l’aire avec le logiciel ImageJ 

28. Définir l’étalon de mesure avec l’outil Set Scale comme décrit aux points 23 à 25;  

29. Transformer l’image en noir et blanc en utilisant l’outil Image > Type > 8-bit (figure 9); 

30. Sélectionner l’outil Image > Adjust > Threshold. Dans la fenêtre Threshold choisir les 

options Default et B&W. Appuyer sur Apply (figure 10);  

31. Sélectionner l’outil Analyze > Tools > ROI Manager (figure 11); 

32. Cocher les options Show all et Labels de la fenêtre ROI Manager Avec l’outil Wand, 

sélectionner une feuille (elle sera encadrée en jaune) puis cliquer sur le bouton Add 

dans la fenêtre ROI Manager. Sélectionner ainsi toutes les feuilles une par une (figure 

12); 

33. Dans la fenêtre ROI Manager, cliquer sur le bouton Measure. La fenêtre qui s’ouvrira 

indique la surface calculée en unité2 (p. ex : mm2) de chaque feuille (figure 12). 

34. Noter les mesures pour chacun des plants. 
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Figure 9 : Pout transformer l’image en noir et blanc, sélectionner l’option 8-bit dans l’outil Type 
du menu Image. 

Figure 10 : Dans la fenêtre Threshold sélectionner les options Default et B&W (encerclé en 

rouge). Ajuster la zone couverte en noir à l’aide des curseurs (encerclé en bleu). 
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Figure 11 : Ouvrir l’outil ROI manager et cocher les cases Show all et Labels. 

Figure 12 : Avec l’outil Wand (encerclé en rouge), sélectionner une feuille (elle sera encadrée en jaune), 
cliquer sur Add (encerclé en bleu) pour l’ajouter à la liste. Cliquer sur chacune des feuilles pour les ajouter à 
la liste. Lorsque toutes les feuilles sont sélectionnées, cliquer sur Measure (encerclé en vert) pour obtenir 

l’air de chaque feuille sélectionnée (Area). 
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Estimation de l’aire moyenne des feuilles par masque, méthode alternative13 

Cette méthode est une alternative à la mesure de la longueur et la largeur des plants. Elle 

remplace les étapes 22 à 28 du protocole. Elle permet une estimation de l’aire des feuilles 

plus rapide, mais ne permet pas de connaître les mesures longueur et de largeur des 

plants ni de connaître le nombre de feuilles par plant. 

 

Matériel 

 Surface blanche : feuille de papier hydrofuge ou laminé blanc (8,5 ‘’ x 11’’) 

 Surface transparente : plaque de verre ou feuille d’acétate ou d’acrylique transpa-

rent (8,5 ‘’ x 11’’) 

 Règle de 15 cm graduée en mm (peut être imprimé directement sur la feuille 

blanche) 

 Étiquettes d’identification (site, transect et quadrat) 

 Photocopieuse ou numériseur 

Pour les trois plants sélectionnés dans l’échantillon :  

35. Couper les feuilles à la base de la gaine puis, sur la surface transparente, étaler les 

feuilles des trois plants. Si les feuilles sont plus longues que la surface, il est possible 

de les couper en plusieurs segments avant de les étendre (figure 8) ; 

36. Placer la règle et l’étiquette d’identification sur la surface transparente, face vers le 

bas. Placer la surface blanche sur le dessus des plants. Veiller à ce que les plants, 

l’étiquette et la règle ne se superposent pas;  

37. Faire une photocopie des plants (figure 13);  

38. La surface totale des feuilles peut être estimée à partir de cette image en utilisant la 

méthode décrite aux étapes 28 à 34. 

  

 
13Tran (2019) 
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Figure 13 : Photocopie des plants d’un même échantillon 
pour l’estimation du LAI.Tous les segments des plants sont 
placés à plat sur une surface transparente ainsi que l’éti-
quette d’identification et une règle graduée. Cette figure 
est tirée de Tran (2019). 
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INDICES 

Indice surface foliaire  

L’indice surface foliaire (Leaf Area Index ou LAI) est une dimension exprimée sans unités 

qui permet d’évaluée l’aire des feuilles en fonction de la surface du sol (ou du substrat). 

Le LAI est calculé en rapportant le total de l’aire d’un côté des feuilles par la surface 

échantillonnée. L’aire totale des feuilles est estimée à partir de la moyenne de la surface 

des trois répliquas. 

On le calcule le LAI ainsi :  

𝑎𝑖𝑟𝑒 𝑡𝑜𝑡𝑎𝑙𝑒 𝑅1 + 𝑎𝑖𝑟𝑒 𝑡𝑜𝑡𝑎𝑙𝑒 𝑅2 + 𝑎𝑖𝑟𝑒 𝑡𝑜𝑡𝑎𝑙 𝑅3

3
 × 𝑑𝑒𝑛𝑠𝑖𝑡é = 𝐿𝐴𝐼 

Exemple de calcul :  

Aire des répliquas 

R1 : 4587 mm2 = 45,87 cm2 = 0,004587 m2 

R2 : 3329 mm2 = 33,29 cm2 = 0,003329 m2 

R3 : 6123 mm2 = 61,23 cm2 = 0,006123 m2 

Densité : 2458 plants/m2 

0,004587 + 0,003329 + 0,006123

3
 × 2458 = 11,50 

𝐿𝐴𝐼 = 11,50 
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Calcul de la FW/DW 

La biomasse foliaire sèche (DW) est obtenue après un séchage des plants à 60⁰C pendant 

48h. Cette mesure de biomasse est le plus souvent utilisée dans la littérature scientifique 

afin de comparer les communautés entre elles. Cependant, le séchage des échantillons 

demande des installations de laboratoire qui ne sont pas accessibles à toutes les organi-

sations impliquées dans le suivi des herbiers marins.  

Un indice préliminaire de conversion entre la masse sèche et la masse humide a été cal-

culé à partir des mesures de biomasse fraîche et sèche de 148 échantillons récoltés à 

Rimouski sur une période de 6 mois (mai à octobre 2023). 

Les données récoltées en 2024 (sur une variété de sites et de dates) serviront à renforcer 

la puissance statistique et assurer l’applicabilité du facteur de conversion.  

𝐷𝑊 = (0,16 ±  0.002)  ×  𝐹𝑊 

𝑅2 = 0.9786  

Tableau 1 : Facteurs de conversion entre masse sèche et masse fraîche pour les données de biomasses 

récoltées à Rimouski en été 2023 

 

Date Pente Intervalle de con-

fiance (95%) 

R2 n Erreur Std 

Été 2023 

 

0.1616 [0.1579; 0.1653] 0.9786 148 0.001881 

2023-05-05 0.2022 [0.1935; 0.2108] 0.9955 12 0.003935 

2023-05-18 0.1844 [0.1761; 0.1927] 0.995 12 0.003777 

2023-06-05 0.1861 [0.1670; 0.2051] 0.9747 12 0.008643 

2023-06-19 0.1746 [0.1631; 0.1860] 0.9894 12 0.005206 

2023-07-05 0.1580 [0.1326; 0.1832] 0.9404 12 0.01145 

2023-07-20 0.1664 [0.1570; 0.1757] 0.9875 18 0.004418 

2023-08-03 0.1481 [0.1384; 0.1579] 0.9893 12 0.004445 

2023-08-17 0.1679 [0.1622; 0.1736] 0.9972 12 0.002577 

2023-08-31 0.1826 [0.1669; 0.1984] 0.9818 12 0.007163 

2023-09-14 0.1397 [0.1321; 0.1472] 0.9928 12 0.003433 

2023-09-28 0.1660 [0.1552; 0.1767] 0.9897 12 0.004878 

2023-10-16 0.1998 [0.1894; 0.2102] 0.9933 12 0.004743 

2023-10-31 0.1563 [0.1494; 0.1632] 0.9957 12 0.003086 
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